Lesson objectives

To learn how to create and enhance organization charts and use Microsoft Graph, you will:

a  Enter chart data by using the Microsoft Organization Chart application.

b  Enhance the organization chart by using Microsoft Organization Chart menu commands.

c  Observe the default chart and datasheet in Microsoft Graph and enter new information.

d  Enhance the chart by using Microsoft Graph menu commands and buttons.

Suggested teaching time 60-70 minutes
Creating an organization chart

PowerPoint comes with an application called Microsoft Organization Chart, which helps you to create charts that show the hierarchical organization of your company or department. When you open Microsoft Organization Chart, it displays a chart template containing boxes. Each box has field labels (or placeholders) for name, title, and comments. You enter data by selecting a box and typing over the field labels.

To enter text into a box:

1. Click on the box in which you want to enter information.
2. Click again to display all of the fields, or start typing to enter data.
3. Press Enter to move to the next line or field.
4. Click outside the box (or click on another box) to deselect it.

![The completed organization chart](image)

Figure 5-1: The organization chart after Task A-1 and the Practice Task have been completed.

Task A-1: Entering data in the Organization Chart AutoLayout

Objective: To add names and titles in organization-chart boxes.

Before you begin: No files are open.

<table>
<thead>
<tr>
<th>What you do</th>
<th>Comments/Prompts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open Organization Chart</td>
<td></td>
</tr>
<tr>
<td>2. Move to Slide 6</td>
<td>Add a new slide</td>
</tr>
<tr>
<td>3. Double-click on the Organization Chart AutoLayout</td>
<td></td>
</tr>
<tr>
<td>4. Add the title Management Team</td>
<td></td>
</tr>
</tbody>
</table>
5. Double-click on the Organization Chart placeholder To open the Microsoft Organization Chart window. The first-level box is open and ready for text to be added.

6. Maximize the window, if necessary

7. Type J. Rivera The name for the first-level box.
   Press R

8. Type President The title for the first-level box.
   Press R

9. Type Relocation Team The text for Comment 1. As you type, the box is enlarged to accommodate the text.

10. Select the first second-level box

11. Type M. Mueller For the name.
    Press R

   Type V. P. Sales For the title.

Practice Task

1. Add the following data to complete the two remaining second-level boxes:
   R. Moore
   V. P. Marketing
   L. Singh
   V. P. Operations

2. Deselect the chart.

Adding boxes to an organization chart

Concepts

The Microsoft Organization Chart window contains its own menu and toolbar. You can use the buttons on the toolbar to add boxes to a chart. Box levels include Subordinate, Left Co-worker, Right Co-worker, Manager, and Assistant.

To add a box to the organization chart:

1. Click on the appropriate box-type button.

2. In the chart, click on the box to which you want to attach the new box.
Task A-2: Adding co-workers and subordinates

Before you begin: Complete the Practice Task at the end of Task A-1.

<table>
<thead>
<tr>
<th>What you do</th>
<th>Comments/Prompts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click on the Subordinate button</td>
<td>To add a subordinate level.</td>
</tr>
<tr>
<td>2. Click on M. Mueller’s box</td>
<td>A third-level box is added below M. Mueller.</td>
</tr>
<tr>
<td>3. Enter the data for the new box: J. Dillon Regional Manager</td>
<td></td>
</tr>
</tbody>
</table>

Practice Task

Add subordinate levels for the other second-level boxes.

R. Michael Marketing Director

J. Jackson Manager, Operations

Refer to Figure 5-2 for placement. You might need to use the horizontal scroll bar to view the entire document.
Deleting and moving boxes

Over time, you might need to change an organization chart. For example, you would change the chart if an employee had left the company or had changed positions within the company structure.

To delete a box from an organization chart:
1. Select the box that you want to delete.
2. Press Backspace or Delete.

To change a box's position:
1. Place the mouse pointer over the box to be moved.
2. Press the mouse button and drag the box over the lower portion of the new manager or co-worker position (until the box is highlighted and the mouse pointer changes shape). Be careful not to drag the box directly over the new manager or co-worker position because this will result in replacing that position.
3. Release the mouse button.

![Organization Chart](image)

Figure 5-3: The organization chart after Task A-3 has been completed.
Task A-3: Deleting and moving boxes

Objective: To change the order of boxes.

Before you begin: Complete the Practice Task at the end of Task A-2.

<table>
<thead>
<tr>
<th>What you do</th>
<th>Comments/Prompts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click on the R. Michael box</td>
<td>To select it.</td>
</tr>
<tr>
<td>2. Press D</td>
<td>To delete the box.</td>
</tr>
<tr>
<td>3. Point to the J. Jackson box</td>
<td></td>
</tr>
<tr>
<td>Drag the box over the R. Moore box</td>
<td>A dotted outline appears as you move the box. The mouse pointer changes shape and resembles the subordinate button.</td>
</tr>
<tr>
<td>4. Release the mouse button</td>
<td>To move the box to the subordinate position under R. Moore.</td>
</tr>
<tr>
<td>5. Verify that the J. Jackson box is selected</td>
<td></td>
</tr>
<tr>
<td>6. Drag to select the title</td>
<td>(Manager, Operations.)</td>
</tr>
<tr>
<td>7. Type Marketing Director</td>
<td></td>
</tr>
<tr>
<td>8. Deselect the chart</td>
<td>Use the horizontal scroll bar to view the entire chart, if necessary.</td>
</tr>
</tbody>
</table>

Step 3 can be tricky. If students drag the box exactly over R. Moore, it will replace the R. Moore box, instead of becoming the subordinate box to R. Moore.
Organization-chart options

Like other drawn objects and text, organization-chart boxes and text can be modified with options such as box border, box color, and box shadows. In addition, you can use the Text menu to edit text within boxes. Before you can make any of these changes, you must select the boxes or levels that you want to change.

Selecting boxes and levels

There are several methods for selecting boxes and levels of an organization.

To select boxes by using the menu:

1. Choose Edit, Select.
2. Choose an option from the submenu.

To select boxes without using the menu:

1. Click on the first box that you want to select.
2. Press Shift and click on the other boxes that you want to select.

To select levels of boxes:

1. Choose Edit, Select Levels.
2. In the Select Levels dialog box, type the number of the levels that you want to edit. For instance, if you want to edit the first two levels of a three-level chart, you would type 1 in the first box and 2 in the second box.
3. Click on OK.

Changing the organization-chart view

When you are working with organization charts, you can change the magnification, or view, of a chart. For example, if you want to edit the data in a chart, you can magnify a particular box. You can also reduce the view of the organization chart, if the chart extends outside the Microsoft Organization Chart window. There are keyboard, toolbar, and menu options to enable this process.

To enlarge the view of, or magnify, an organization chart:

1. On the Organization Chart toolbar, click on the Zoom button.
2. Place the mouse pointer anywhere on the chart or on the box that you want to view. The mouse pointer changes to a magnifying glass.
3. Click the mouse button.

To reduce the view of an organization chart so that you can see the entire chart:

1. On the Organization Chart toolbar, click on the Zoom button.
2. Place the mouse pointer anywhere on the chart. The mouse pointer changes to a miniature organization chart.
3. Click the mouse button.
### Task B-1: Editing chart text and changing magnifications

<table>
<thead>
<tr>
<th>What you do</th>
<th>Comments/Prompts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. On the toolbar, click on the Zoom button</td>
<td>The mouse pointer changes to a magnifying glass.</td>
</tr>
<tr>
<td>2. Click anywhere on the chart or chart background</td>
<td>To increase the chart magnification to 100%.</td>
</tr>
<tr>
<td>3. Observe the Zoom button on the toolbar</td>
<td>The graphic has changed, although the button is still called the Zoom button.</td>
</tr>
<tr>
<td>4. Click on the Zoom button and click anywhere in the chart</td>
<td>To reduce the chart’s magnification. The chart is sized to the window.</td>
</tr>
<tr>
<td>5. Choose <strong>Edit</strong> <strong>Select</strong> <strong>All Managers</strong></td>
<td>To select all boxes with employees reporting to them.</td>
</tr>
<tr>
<td>6. Choose <strong>Text</strong> <strong>Font...</strong></td>
<td>To display the Font dialog box.</td>
</tr>
<tr>
<td>Under Font Style, select Bold</td>
<td></td>
</tr>
<tr>
<td>Click on OK</td>
<td>To add bold formatting to the text in the selected boxes.</td>
</tr>
<tr>
<td>7. Choose <strong>Boxes</strong> <strong>Color...</strong></td>
<td>To display the Color dialog box.</td>
</tr>
<tr>
<td>Select a shade of gray</td>
<td></td>
</tr>
<tr>
<td>Click on OK</td>
<td>To change the color of the managers’ boxes.</td>
</tr>
<tr>
<td>8. Deselect the boxes</td>
<td>(Click anywhere outside of the boxes.)</td>
</tr>
<tr>
<td>9. Choose <strong>View</strong> <strong>50% Of Actual</strong></td>
<td>To increase the chart size to 50% of actual size.</td>
</tr>
<tr>
<td>If necessary, scroll to view the boxes</td>
<td></td>
</tr>
<tr>
<td>10. Choose <strong>File</strong> <strong>Exit And Return To Organization Chart.ppt</strong></td>
<td>To update the object and return to your PowerPoint presentation.</td>
</tr>
<tr>
<td>Click on Yes</td>
<td></td>
</tr>
<tr>
<td>11. Save the file as My Organization Chart</td>
<td></td>
</tr>
</tbody>
</table>
Orientation to Microsoft Graph

PowerPoint comes with an embedded application called Microsoft Graph. In Microsoft Graph, you can create charts, which are graphic representations of numeric data, and bring them into your presentation. Like other embedded objects, you can copy, delete, or size a chart by using PowerPoint's toolbars and menu commands. Microsoft Graph has 14 chart types and several formatting options.

To start Microsoft Graph, click on the Insert Chart button on the Standard toolbar (or choose Insert, Chart, or double-click on a chart placeholder in a chart AutoLayout).

The Microsoft Graph window contains two windows: the Chart window and the Datasheet window. The Datasheet window is where numerical data is displayed. The Chart window is where the data is displayed in graphical form. When you open Microsoft Graph, the Datasheet window and the Chart window contain sample default data and a sample chart based on the default data.

The Datasheet window

The datasheet contains the numeric data, which is the source used to create your chart. The datasheet also contains text, which is the legend and series labels for your chart. Use the datasheet to type and edit data. Row and column headings are the dark boxes located to the left of the rows and above the columns; they are used to identify and select rows and columns on the datasheet. The intersection of a row and a column is referred to as a cell. For example, the intersection of column A and row 1 is cell A1.

The Chart window

As you enter or change data in the datasheet, Microsoft Graph automatically applies those changes to the chart in the Chart window. The chart style can be changed at any time in the Microsoft Graph window. In addition, other formatting options are available by accessing the menus and toolbars. Shortcut menus, which provide easy access to commonly used formatting commands, are also available in Microsoft Graph.
PowerPoint 2000: Introduction

Ashbury Training

5 - 10

Figure 5-4: The Microsoft Graph default chart.

Task C-1: Observing the default chart

Objective: To view the default chart screen and some of its components.

<table>
<thead>
<tr>
<th>What you do</th>
<th>Comments/Prompts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Add a new slide with the Chart AutoLayout</td>
<td>Type the title First Quarter Sales</td>
</tr>
<tr>
<td>2. Double-click on the Chart placeholder</td>
<td>To display the default chart and datasheet.</td>
</tr>
<tr>
<td>3. Observe the datasheet</td>
<td>The Microsoft Graph toolbars are displayed because the Microsoft Graph application is running.</td>
</tr>
<tr>
<td>Click on the View Datasheet button</td>
<td>It contains sample default data.</td>
</tr>
<tr>
<td>4. Observe the default chart</td>
<td>To close the Datasheet window.</td>
</tr>
<tr>
<td>Observe the Category axis (x-axis)</td>
<td>A column chart displays three sets of colored bars.</td>
</tr>
<tr>
<td>Observe the Value axis (y-axis)</td>
<td>It displays the labels 1st Qtr, 2nd Qtr, 3rd Qtr, and 4th Qtr.</td>
</tr>
<tr>
<td></td>
<td>It displays a scale from 0 to 90.</td>
</tr>
</tbody>
</table>
5. Observe the legend It displays the labels East, West, and North.

6. Click outside the chart area To return to the presentation in Normal view.

7. Double-click on the chart To return to the Chart window.

---

**Working with the datasheet**

*Concepts>*

To enter data on the datasheet, select a cell, and then type the data. The cell surrounded by a darkened border is the *active cell*. You can use the mouse or the arrow keys to select a cell. If there is any data in the cell that you select, the new data you type will replace the contents of the cell.

To simultaneously select more than one cell in the datasheet, you can use one of the following methods:

- Drag to select the cells.
- Double-click on a column heading to select an entire column, or double-click on a row heading to select an entire row.
- Click in the cell in the upper-left corner of the datasheet, at the intersection of the column headings and row headings, to select all cells in the datasheet.

**Excluding a row or column of the datasheet from the chart**

Excluding a row or column from the datasheet removes that data from the chart without deleting it from the datasheet.

To exclude a row or column of data in the datasheet from the chart, double-click on the column or row heading for the column or row that you want to exclude.

**Deleting a row or column from the datasheet**

To delete a row or column from the datasheet and exclude the data from the chart, you can use the Edit, Delete command.

To delete a row, column, or cell:

1. Select the row, column, or cell.
2. Choose Edit, Delete. The Delete dialog box is displayed.
3. Select one of the Shift Cells options, or select Entire Row or Entire Column.
4. Click on OK.

If you use the column or row headings to select a column or row and then choose Edit, Delete, the column or row will be immediately deleted.

To delete all of the data on the datasheet at once, click on the Select All button (the first darkened box in the upper-left corner, below the Control-menu box) and press Delete.
Figure 5-5: The Microsoft Graph default datasheet displayed over the chart.

Task C-2: Deleting default data and adding column headings

Objective: To enter new data and column headings.

<table>
<thead>
<tr>
<th>What you do</th>
<th>Comments/Prompts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click on the View Datasheet button</td>
<td>To display the datasheet.</td>
</tr>
<tr>
<td>Drag the Datasheet window to the top of the screen, if necessary</td>
<td>To view a portion of the chart.</td>
</tr>
<tr>
<td>2. Click on the Select All button</td>
<td>(The first gray box in the upper-left portion of the datasheet.) To select the entire datasheet.</td>
</tr>
<tr>
<td>Press D</td>
<td>To delete the default data and column headings. The default chart is no longer displayed.</td>
</tr>
</tbody>
</table>
3. Click on the first blank cell under column A
   Type National
   The first column heading.
   Press T
   To move one cell to the right.

4. Type Overseas
   The second column heading.

---

**Entering information in the datasheet**

To enter information in the datasheet:

1. Activate the cell in which you want the data to be displayed.
2. Type the data.
3. Press Enter to complete the entry and move down the column one cell, or press Tab to complete the entry and move to the right one cell.

---

**Task C-3: Adding series names and data**

<table>
<thead>
<tr>
<th>What you do</th>
<th>Comments/Prompts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the first blank cell in row 1</td>
<td>The first series.</td>
</tr>
<tr>
<td>2. Type Projected</td>
<td>To move down the column one cell.</td>
</tr>
<tr>
<td>3. Press R</td>
<td>The second series.</td>
</tr>
<tr>
<td>4. Type Actual</td>
<td>(Under the word “National.”) The cell is referred to as cell A1.</td>
</tr>
<tr>
<td>5. Select the cell to the right of Projected</td>
<td>The value for cell A1.</td>
</tr>
<tr>
<td>6. Type 225</td>
<td>To move to the right.</td>
</tr>
<tr>
<td>Press T</td>
<td>The value for cell B1.</td>
</tr>
</tbody>
</table>
Practice Task

1. Enter the following data for Actual:
   250  375

2. Close the datasheet to observe the chart.
Editing a column chart

When you make changes to the datasheet, Microsoft Graph updates the chart automatically. To add data to a chart, you can type directly on the datasheet or copy and paste data from another location.

To modify data in a cell:

1. In the Datasheet window, select the cell that you want to edit.
2. Enter the new data.
3. Press Enter or Tab, or click on another cell.

Task D-1: Editing the datasheet

Before you begin: Complete the Practice Task at the end of Task D-3. The datasheet is closed.

<table>
<thead>
<tr>
<th>What you do</th>
<th>Comments/Prompts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Display the datasheet</td>
<td>(Click on the View Datasheet button.)</td>
</tr>
<tr>
<td>2. Select cell B2</td>
<td>It contains the number 375.</td>
</tr>
<tr>
<td>3. Type 475</td>
<td>To change the number of Actual sales for Overseas.</td>
</tr>
<tr>
<td>4. Press R</td>
<td></td>
</tr>
<tr>
<td>5. Observe the chart</td>
<td>The bar for Actual sales has changed.</td>
</tr>
</tbody>
</table>

Practice Task

1. Change the Actual number for National to 280
2. Observe how the chart changes.

Legend placement

In Microsoft Graph, charts can be formatted as an entire chart area or one item at a time. When you select a chart item, you can choose commands from the shortcut menu or from the Format menu. In the Format menu, the selected item is displayed as the first command on the menu. For instance, if the legend is selected, the first item displayed on the Format menu is Selected Legend.

The Formatting dialog box contains tabs that offer related formatting options, such as Placement. To activate a tab, click on it.
To change the placement of the legend:

1. Verify that the Microsoft Graph window is active.
2. Click on the legend.
3. Click the right mouse button to display the Legend shortcut menu.
5. Select the Placement tab.
6. Select a placement option.
7. Click on OK.

### Task D-2: Changing legend placement

<table>
<thead>
<tr>
<th>What you do</th>
<th>Comments/Prompts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. If necessary, close the datasheet</td>
<td>Observe the chart</td>
</tr>
<tr>
<td></td>
<td>The data labels, series, and legend are displayed.</td>
</tr>
<tr>
<td>2. Point to the legend</td>
<td>Right-click the mouse button</td>
</tr>
<tr>
<td></td>
<td>To display the shortcut menu for the legend.</td>
</tr>
<tr>
<td>3. Choose <em>Format Legend...</em></td>
<td>Choose <em>Format Legend...</em></td>
</tr>
<tr>
<td></td>
<td>To display the Format Legend dialog box.</td>
</tr>
<tr>
<td>4. Select the Placement tab</td>
<td>Select Bottom</td>
</tr>
<tr>
<td></td>
<td>To display the Placement options.</td>
</tr>
<tr>
<td>5. Select Bottom</td>
<td>Click on OK</td>
</tr>
<tr>
<td></td>
<td>To move the legend to the bottom of the chart.</td>
</tr>
</tbody>
</table>

### Chart types

There are 14 chart types in Microsoft Graph. In addition, each chart type has variations, or subtypes. By default, when you enter data in the datasheet, the data is displayed as a column chart. Changing the chart type can sometimes help you present data more effectively. For example, if the data you are presenting compares parts to a whole, such as the quarterly revenue of a product, a pie chart can show the comparison more clearly than a column chart.

To change the chart type by using the Chart Type button:

1. Verify that the Microsoft Graph window is active.
2. Click on the drop-down arrow next to the Chart Type button to display the available chart options.
3. Select a chart type.
To change the chart type by using the menu:

1. Verify that the Microsoft Graph window is active.
2. From the shortcut menu or the Chart menu, choose Chart Type.
3. Select the Standard Types or Custom Types tab.
4. Select a chart type, and then select a chart subtype.
5. Click on OK.

![First Quarter Sales chart](image)

*Figure 5-6: The chart in My Organization Chart.*

**Task D-3: Changing the chart type**

<table>
<thead>
<tr>
<th>What you do</th>
<th>Comments/Prompts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. On the Standard toolbar, click on the drop-down arrow next to the Chart Type button</td>
<td>To display the Chart Type drop-down list.</td>
</tr>
<tr>
<td></td>
<td>If the Chart Type button is not displayed, click on the More Buttons button and click on the Chart Type button.</td>
</tr>
<tr>
<td>2. Select the 3-D Bar Chart</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Observe the chart</td>
<td>The bars are displayed horizontally.</td>
</tr>
</tbody>
</table>

Let students try other chart-type options before returning to the PowerPoint slide.
4. Click away from the selected chart To return to the slide.

5. Save and close the presentation
Practice Unit for Lesson 5

In this activity, you will create a three-level organization chart, add a border, and change the chart style. Then you will create a column chart and enter data that compares this year’s cruise sales to last year’s sales. To check your work, you can refer to Figures 5-7 and 5-8.

1. Create a new, blank presentation by using the Organization Chart AutoLayout.
2. Add the title Organization Chart
3. Create the chart shown in Figure 5-7.

![Organization Chart](image)

Figure 5-7: The organization chart after step 3 of the Practice Unit has been completed.

4. Select all of the boxes, and change the box color and box border.
5. Select the second-level boxes and change the font style.
6. Add a new slide with the Chart AutoLayout.
7. Enter the title Regional Sales
8. Start Microsoft Graph.
9. Delete the default data.
10. Complete the datasheet as follows:

![Presentation2 - Datasheet](image)

Figure 5-8: The completed datasheet.

11. Place the legend at the bottom of the chart.
12. Save the presentation as My Chart & Graph and close the file.
Wrap-up for Lesson 5

a  Describe how to add a Co-worker level box to an organization chart.
   On the Microsoft Organization Chart toolbar, click on the desired Co-worker button, and then click on the existing box that you want to place the new box next to.

b  List two ways to change the magnification of a chart in the Microsoft Organization Chart window.
   1. Display the View menu and choose one of the magnification commands.
   2. Click on the Zoom button and click anywhere on the chart.

c  How do you quickly delete all of the data on a datasheet?
   Click on the Select All button and press Delete.

d  List the steps to change the legend placement.
   1. Select the chart and right-click on the legend.
   2. Choose Format Legend and select the Placement tab.
   3. Select a placement option.
   4. Click on OK.